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CHAPTER 1

INTRODUCTION

1.1 Background

Emotions are referred to as human feelings such as anger, sadness and happiness. In
our daily life, emotions play an imperative role as every thought and action controls
and dominates through our emotional past experiences. They shape our future
responses and prepare our actions to different situations and activities (Ramaprasad,
2013). Thus, it plays an important role in our life. In this study, stress emotion is
focused upon as it has proven to be a popular and significant topic in recent years. In
modern society, individuals are expected to acquire latest information, competitive
skill sets and intrinsic relationship network. Such expectations create high tension
environment in life and cause over capacitance of emotional control; thus leads to
stress. As reported in a study, overstress in an individual may create somatopsychic
abnormalities due to inability to adapt to stressful situations. Each individual has

unique stress limit based on life conditions and tolerance (Otsu et al., 2012).

Human brain is known as one of the greatest complex structures in the
creation as it acts as the control center of nervous system in a human body. Minor
changes in surroundings such as smell, sound and light can be detected and
interpreted in the brain before performing an action. After brain interpretation,
examples of actions performed are muscle movement and organ regulation in human
body (Russell, 2013). The response-action activity of the brain involves the electric

field changes through numerous thousand neurons inside the brain. The electrical
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field transfer can be detected via specific devices to track brain activity changes in

electrical potential difference measurement (Kenemans, 2013).

There are several techniques that can be utilized to monitor brain activity.
Techniques or sensors such as Magneto-encephalography (MEG), Positron Emission
Tomography (PET) and Functional Magnetic Resonance Imaging (fMRI) are a few
examples of brain monitoring devices. Yet, these methods are considered costly and
technically demanding with distinctive method and equipment for monitoring brain
activity respectively. Hence, another technique was proposed as it is more reliable
and common to monitor the physiological signals such as Electroencephalogram
(EEG). It is reported to be an effective way to identify human stress as it has high
temporal resolution with relative simple and inexpensive equipment (Schalk &
Mellinger, 2010).

Based on Oxford dictionary, music can be defined as a form of art that creates
a composition through the combination of vocal or instrumental sounds. In fact,
music helps an individual to perform tasks in a more efficient way. Furthermore,
many research studies have showed that background music has its positive impact
toward patients with moderate patient condition (Wang, Wen & Liu, 2016). This led
to the development of music therapy which acts as a supplement of medicine or
medicinal treatment. Yet, it was observed that music therapy impacts different people
differently due to their mental conditions, age group and health conditions (Pingle &
Bhagwat, 2015). Thus, music will be induced in this study to observe its influence
towards stress level of an individual. Hence in this study, the effect of music on the

EEG signal of human brain will be studied.

1.2 Problem Statement

In this study, stress is defined as a psychological term that is consists of type of
emotions which are invisible to human eye. It can have many causes internal (e.g.
some illness) or external (e.g. homework, exam, relationship difficulties). Everything

that human being face may cause the pressure that result in the stress level to
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increase. Impact of stress can be varied depending on tolerance level of an individual.
For example, appropriate stress level can motivate human beings to stay focused and
alert in the working place. In contrast, if the stress level increases beyond a certain
threshold, it may affect the health, mood, productivity and life quality.

Many researches showed that excessive stress can affect the overall health,
especially mental illness causing anxiety and depression. These are the effects that
are commonly observed in day to day life and which may become worse if not
treated quickly and correctly. According to Biswas, (2017), a 21-year-old student of
Osmania University committed suicide in Hyderabad on 3 December 2017. It was
reported that the student was unable to withstand his examination stress. Other than
that, close to 40,000 students committed suicide in India from 2011 to 2015 revealed
by National Crime Records Bureau (NCRB). In India, tremendous pressure is faced
by the students as competitions are fierce and examination determines their future
(HT Brand Studio, 2017). Besides, the World Health Organization (WHO) also
reported that over one million people commit suicide every year. In Malaysia, most
people commit suicide as they are unable to deal with higher pressure in school and
work as reported by Yesuiah, (2017). Therefore, we aim to investigate and analyze
the EEG signal under different stress levels and to identify whether the music can be

used to reduce the stress.

1.3 Aims and Objectives

To pre-process the EEG signal for analyzing data accurately.
To investigate and analyze the stress level by using EEG.
To identify how the music influences the stress level.

> w0 np e

To understand the relationship between the beta band and stress as well as the

relationship between alpha band and music behavior.



CHAPTER 2

LITERATURE REVIEW

2.1 Introduction

In this chapter, all basic concepts used in this research will be briefly discussed
which include electroencephalogram (EEG), brain rhythm, brain anatomy, nervous
system, electrodes positioning and Stroop Color-Word Test. Literature review will be

covered in this research to understand the project clearly.

2.2 Electroencephalogram (EEG)

In 1924, Hans Berger, a German physiologist had recorded the first human EEG
signal (La Vaque, 1999). Even though it is a traditional technique, the development
of reliable computer-assisted EEG-analysis had been improved through technological
and scientific advances over the years (Amorim et al., 2017). Nowadays, EEG aid in
electrical activity diagnosis of the brain that may detect certain diseases and their
symptoms. For different brain activities, the EEG traces will be different. It can
differentiate the abnormality of brain activity based on the normal one through signal
processing methods (Subha et al., 2010). Basically, EEG signal is described as
bioelectric potential produced from millions of neuron links in the human brain and it
can be detected from human scalp by using the flat small metal discs (electrodes) via
wires. The electrical impulses will be analyzed through the electrodes and the

produced signals will be recorded in the computer. The electrical impulses recorded
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by EEG look like wavy lines with different characteristics. These lines would
identify presence or absence of abnormal patterns in the signals which may indicate

signs of head injury or other brain disorders (Blocka, 2017).

EEG as a noninvasive test that is painless and extremely safe. The EEG does
not produce any harmful secondary effect. However, EEG may cause seizures during
the stimulation test for an individual who had experienced a seizure disorder. This is
due to the deep breathing or light flashing that might require during the test which
can triggered seizures (Vrocher & Lowell, 2005).

2.3 Nervous System and Brain Anatomy

There are two types of cells that make up the entire nervous system; these are known
as nerve cells (neurons) and glial cells (neuroglia) (Dartmouth.edu, 2017). Normally,
neurons transmit information from one cell to another, while neuroglia aid in the
information transmission and help to maintain neuron surrounding. Based on the
structure of neuron as shown in Figure 2.1, a neuron consists of a nucleus at its head
known as soma and it runs along a path known as axon that is covered by a myelin
sheath. It receives the information from dendrite and carries it through axon.
According to Nordstrém and Tangmark, (2013), the electrical signals are generated
whenever nerve cells communicate with each other. As the neuron undergoes certain
concentration changes of potassium (K+) ions, sodium (Na+) ions and chloride (CI-)
ions, an electrical signal is generated. By doing so, it allows the nerve cell to
transport the electrical charge via long axon fiber. In addition, the myelin sheath is
actually a neuroglia. The refractory period allows the electrical signal travel in one
direction only (Nordstrom & Tangmark, 2013). Hence, the signal can then be

transferred from one end to another end through synapses.
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Figure 2.1: Nerve Cell Structure (Nordstrom & Tangmark, 2013)

As mentioned previously, the most significant and complex organ in human
body is the brain. The brain allows human being to sense, smell, think and move. It
allows humans to respond properly when a stimulus is received from environment.
The human brain is co-divided into three main structures which are cerebrum,

cerebellum and brainstem.

Firstly, cerebrum is the biggest region of the brain that deals with major brain
function like action and thought. The cerebrum is the cerebral hemisphere or cerebral
cortex which can be divided into two parts namely right hemisphere and left
hemisphere. The right hemisphere corresponds with verbal processes and the
information from left side of the body whereas the left hemisphere is involved with
the nonverbal processes and right side of the body (Northeastern.edu, 2017; General
Psychology, 2017). Cerebral cortex is divided into four different lobes divided
known as frontal lobe, temporal lobe, parietal lobe and the occipital lobe (Damasio,
2005). The general function of each lobe is described below and their visual

representations are given in Figure 2.2.

e Frontal lobe
- It is located at the front region of the brain and manages personality,
feeling, high level cognition, body movement, speech, writing and self-

awareness.



e Temporal lobe
- It is found at the bottom of brain. It aids in the language, sound and
memory formation as also sequence and organization.
e Parietal lobe
- It is located behind frontal lobe and above temporal lobes. It controls
auditory, vision, sensory information, memory and language signal
interpretation
e Occipital lobe
- It is placed behind the parietal and temporal lobes at the back region of
brain. It is involved in visual stimuli and information interpretation or

vision.

Secondly, another brain structure is cerebellum which is the smaller part of
the brain compared with cerebrum. It is found at the top of the brainstem and below
the cerebrum. It deals with the movement regulation, posture control and balancing
(Northeastern.edu, 2017; General Psychology, 2017).

The smallest brain structure is brainstem which links both cerebrum and
cerebellum to the spinal cord in order to form a pathway for signal transmission.
There are three regions consisting in the brainstem which including midbrain, pons
and medulla. All of them help in certain basic body functions such as breathing,
heartbeat, blood pressure, control of sleep cycles and the body movement
(Northeastern.edu, 2017; General Psychology, 2017).

Frontal Lobe Parietal Lobe

Occipital Lobe

Temporal Lobe

Brainstem

Figure 2.2: Brain Anatomy (Human Anatomy Structure, 2017)



2.4 Brain Wave / Rhythm / EEG Signal

The brain wave can be defined based on its uses. Hsu, (2017) stated that numerous
neurons (brain cells) are required to work together in order for human brain cells to
communicate with each other. Any behavior or thought that was activated from brain
cells is generated from the action potential as the nerve impulses transmitted from
one neuron to another and this action potential is normally known as electrical signal
itself. Whenever these signals are recorded through EEG, it can be observed on the
computer screen as waveforms of varying amplitude and frequency (sinusoidal)
typically measured in microvolts (Teplan, 2002). The EEG waveforms are also
known as brain waves or brain rhythms which are classified based on their
amplitudes, shapes, frequencies and the location of electrode on the of scalp
(Sucholeiki, 2012). Generally, humans consist of five different types of brain waves
such as gamma wave, beta wave, alpha wave, theta wave and also delta wave
(Trivedi & Thakker, 2016). Each wave is categorized in terms of frequency (Hertz)
which can be divided into different bandwidths. They can also be further classified as

low, moderate and fast waves.

Brief descriptions about the information of distinct brain waves are given as below:
» Gamma Waves
- There is no “gamma state” in mind, they always act as a “supporter”
waves. They are mostly present in EEG signal whenever the subject is
awake.
- They are linked to idea formation, thinking, learning and memory
processing.
- They are not present during deep sleep when anesthesia is induced, yet it
appears back during the wakeful state.
- They normally result in high level of intelligence and self-control.
> Beta Waves
- They are for found during the ‘fight flight response’ in human.
- They are present when the individual is in a situation which requires
problem solving, decision making, conscious thought and external effect.
- They help to improve logical thinking and concentration.

- There are three different categories of beta waves:
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= Low beta waves (14 Hz — 17 Hz): waves that present when
someone is concentrating in meditation.

= Midrange beta waves (17 Hz — 24 Hz): waves that would be
activated when an individual is figuring something out.

= High beta waves (25 Hz — 30 Hz): waves produced during more

complex thought, higher anxiety, worry, stress and excitement.

» Alpha Waves

These waves appear when individuals are relax but in awake state (closed
to low beta waves)
They help to calm down, alertness and mental coordination or promote

deep relaxation sense.

> Theta Waves

These often appear during daydreaming and sleeping.

They help to enhance our intuition, conscious awareness an also creativity.

> Delta Waves

They are associated with the deepest level of meditation, relaxation or
sleep and involved in unconscious bodily function.

They will improve healing and regeneration of human body.
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Figure 2.3: Brain Waves (Ecodercrypt, 2013)
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Table 2.1: Details of Brain Waves — Summary (Scientific American, 2017;
Warner, 2013)

Band Frequency Associated with Conditions
(Hz) (Example)
Gamma | 31 —100 - Focused attention -

- Process information from

other areas of brain

Beta 14 - 30 - Thinking state A person who in active
- Intellectual activity conservation.
- Focused sustained

concentration

Alpha 8 - 13 - Relaxation state A person who has finished a
- Peacefulness task and rest on a chair.
- Alertness
Theta 4 -7 - Mental inefficiency A person who discovers that

he can’t recalls the food that
he has ate just now while he
IS eating.

Delta <4 - Deep dreamless sleep A person who reads a book
for a few minutes before

sleep.

Based on above descriptions, the beta wave is the most relevant band that can
be used to indicate the stress level of an individual in this study. It can be noticed that
an individual who suffers with higher stress level will produce high beta band
whereas low level of stress create lower beta band. Moreover, it can also be observed
through the alpha band which has opposite function than beta band. Thus, these two
bands are the main waves that will be used to identify the stress level in the recorded
EEG signals.
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2.5 Electrode Positioning

An internationally recognized method to describe the electrode location on the scalp
since 1950s is known as 10/20 system or International 10/20 system (Trans Cranial
Technologies Ltd, 2012). It is based on the relationship between the electrode
location and the cerebral cortex underlying region. The names of the system numbers
- “10” and “20” are actually referred to as two adjacent electrode’s distances which
are either 10% or 20% (Trans Cranial Technologies Ltd, 2012). According to Seeck
et al.,, (2017), the electrode locations will be identified through the letters and
numbers (odd and even) which are used to indicate those underlying regions (Table
2.2) and hemispheres respectively. The even numbers are located on the right
hemisphere while odd numbers are located on the left hemisphere (Seeck et al.,
2017). The lowercase ‘z’ or “zero” referred to electrodes annotated on the anterior-
posterior midline. There are only four lobes present in our brain. Thus, the term “C”
is used as a vertex mark only when the central coronal plane is measured from the

left pre-auricular point to right pre-auricular point.

Based on Figure 2.4, the lateral view (Figure 2.4-A) of skull shows the
measurement method from nasion to inion. As mentioned above, the distance from
nasion to inion is indicated in the percentages of 10% and 20%. It is notable that the
measurement between front and back starts from nasion through the vertex “C” to
inion. The Fp and O electrodes are located 10% away from nasion and inion
respectively whereas the rest electrodes are 20% separated from each other by
considering distance as total 100% (Klem et al., 1999). This case is similar for the

distance which shows in Figure 2.4-B from left to right auricular point.

In recent years, an extended new standard of 10/20 system has been
introduced known as 10/10 system (see figure 2.5), in which the gaps between
adjacent 10/ 20 sites defined additional positions that covered 20 % of the
circumference of the head (Kenemans, 2013). However, the original standard system
will still be used in this study through Emotiv EPOC headset which will be covered
in next chapter. As the headset used in this study is based on the 10/20 standard

which is easy to use.
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Table 2.2: Relationship between Electrodes (Letters) and Brain Lobes

Electrode (Letters) Brain Lobe/ Brian area
F Frontal
T Temporal
C “Central”
P Parietal
@) Occipital

Note: “Central” is vertex mark not brain area

2095 WErtex

T
109%
—

Masion

------
FPreaurical
point

Inion  10%
Figure 2.4: The Electrode Measurement Method in (A) Lateral View and (B)
Top View (Malmivuo & Plonsey, 1995)

10-10 positions

75 electrodes with A1, A2

Figure 2.5: The 10/10 and 10/20 Systems for Electrode Placement (Kenemans,
2013)
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2.6 Stroop Color-Word Test (SCWT)

The Stroop Color-Word Test (SCWT) is the oldest and common test used in psycho-
physiological field since the initial work done by Stroop, (1935). Typically, it is used
for investigative response inhibition and executive functions (Schiehser & Bondi,
2009). SCWT consists of several versions and some versions have been translated to
other languages for the wider population coverage. In the standard form of SCWT,
there are three different formats that are commonly used in experiments (Table 2.3).

Table 2.3: Standard Form of SCWT

Format Remarks

1 - Figure 2.6 Read the words painted with ink patches. (e.g. word reading)

2 —Figure 2.7 Name the colors painted on the words that are similar to the
(Congruent) names of colors (e.g. color naming)

3 —Figure 2.8 Name the colors painted on the words that are different to the
(Incongruent) names of colors-words. (e.g. color naming)

Other modified versions of SCWT also follow the same format, yet one or
more dimensions may be varied such as the presentation formats, color displays (e.g.
symbols, shapes or dots), number of colors and trails length (Schiehser & Bondi,
2010). In this study, the congruent and incongruent formats will be used in which an
individual is required to press the color representation key in keyboard to response
the color instead of word. In general, it is based on the observation whether an
individual can read the word faster after identifying the word and name of colors
(Golden & Freshwater, 1978). The longer response time that an individual requires to
perform the test is normally known as the interference or Stroop effect (Lemercier et
al., 2017). Since the SCWT corresponds with the cognitive performance which is
influenced by the stress, thus the time required for more stressful person will be
longer as compared with less stressful person. In other words, the response times will

be varied and will indicate the level of stress of an individual.
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Figure 2.6: (a) Format 1: Word Reading, (b) Format 2- Congruent Image:
Color Naming, (c) Format 3 - Incongruent Image: Color Naming (Jesus Gil
Hernandez, 2014)

2.7 Previous Studies and Related Works

Kalas and Momin, (2016) concluded that the EEG signal can be used for stress
detection. In their paper, the EEG data was collected from 10 subjects. The EEG data
was analyzed into two ways. Stress indices and feature extraction which used for
threshold value extraction and dataset redundancy reduction, respectively (Kalas &
Momin, 2016). Besides, Vanitha and Krishnan, (2016) also conducted a similar
experiment for detecting stress level using EEG signal. They included six healthy
subjects in the experiment and the EEG signals were collected through Emotiv
EPOC headset. In their experiment, they were given some varied difficulty level and
mathematical questions to solve in a specific time period. The whole procedure
lasted 20 minutes where the first and last three minutes were relaxation period and 14

minutes in between were divided into seven minutes of low and seven minutes of
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high level difficulty. The non-stationary EEG signal was then extracted through
Hilbert Huang Transform (HHT) based on the relevant features in time frequency
domain. By doing so, the hidden information in the signal can be investigated. After
that, the feature result from HHT was used for classification. The accuracy of
classification was 89.07% (Vanitha & Krishnan, 2016). Thus, the result has showed
that the EEG has the feasibility to detect the stress.

Hou et al., (2015), conducted an experiment where data was collected from
nine mentally healthy subjects; in the range age of 21 to 28 years. In their study, the
SCWT was applied to induce distinct stress levels in different subjects. It consists of
four sections which are resting, congruent, incongruent 1 and incongruent 2. Each
section was about three minutes long and the EEG data was collected all the time.
For every section of tests, subjects were required to rate out from 1 to 9 in the
questionnaire as stress level representation. Based on the questionnaire, it was found
that subjects’ stress level was divided into three groups: 2-level, 3-level and 4-level.
Besides that, three features were extracted from the collected data which were power
feature (extract power band — theta, alpha and beta), fractal dimension (extract and
measure the complexity and irregularity of the signal) and statistical (measure mean,

standard deviation and so on) (Hou et al., 2015).

Another study was carried out by Jun and Smitha, (2016) in order to
investigate the brain wave’s pattern when the mental stress was induced. 10
participants from age group 20 to 35 years were involved in the experiment. In this
study, two major tests of SCWT and mental arithmetic test were used to indicate the
stress level. There were two stages in the experiment which were ‘training phase’
and ‘testing phase’. The training phase was divided into three sections where three
minutes resting section, three minutes SCWT with 20 seconds rest time for second
section and three minutes mental test with 20 seconds rest time for the last section.
Besides, ten trails were included in the testing phase where each trail was 30 seconds.
In this period, the resting stage, SCWT and mental test were played randomly. After
that, the experiment followed with survey and 20 second rest time. The band power
feature is used to extract band power value of high (beta) and low frequency
components (alpha and theta) and SVM is used as classifier. After classification, it

was noticed that the alpha band power was higher than power of 6 and  band during
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resting section. It was also found that the beta band power was relatively much
higher than theta and alpha in the section of SCWT and mental arithmetic test. As the
result, it had obtained 88% and 96% accuracy for SCWT and mental arithmetic test
respectively in the stress level detection which is higher than the one reported in Hou
et al., (2015) (Jun & Smitha, 2016).

Based on the study mentioned above, it can be noticed that various ways of
analysis and classification of EEG data had been used. In our study, we plan to use
power spectral analysis (power feature) and time series analysis (composite
permutation entropy index and sample entropy) to extract the features instead of
using such HHT, fractal dimension, statistical which will be explained in detail in
next chapter. The table below briefly discussed the methods reported in literature to

analyze stress level.

Table 2.4: Summary of Literature Review

Authors Input Signal Feature extraction Classifier
method (Processing
Technique)
Vanitha, L and | Electrocardiogram i) Time  domain | -Self-Organizing
Suresh, G.R. (ECG) analysis MAP (SOP)
(2013) -Heart Rate | -Support  Vector
Variability ~ (HRV): | Machine (SVM)
useful for evaluating | =»Accuracy =
function of cardiac | 91%
autonomic.

i) Frequency domain
analysis

-Calculate the power
spectral
HRV.

density of
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Xu, Q., Nwe, | Electroencephalogra | - Power spectral for | -Clustering-based
T.L. and Guan, | m (EEG) EEG analysis
C.,Guan - (Band used - HRV for ECG Sensitivity
(2015) Delta, Theta, Alpha | -mean and standard | analysis
and Beta) deviation for GSR
-Electrocardiogram and EMG
(ECG)
-Electromyography
(EMG)
-Galvanic Skin
Response (GSR)
Munla, N., | Electrocardiogram i)Time domain | -K Nearest
Khalil, M., | (ECG) analysis Neighbor (KNN)
Shahin, A. and -HRV -radial basis
Mourad, A ii)frequency  domain | function (RBF)
(2015) analysis -Support  Vector
-Lomb periodogram Machine (SVM).
iii) Time-frequency
domain analysis
-Wavelet and STFT
iv)non-linear analysis
--Sample
Entropy ,DFA-aland
DFA-a2;detrended
fluctuation  analysis
(dfa)
Setz, C., | Electrodermal Using wrapper | -Linear
Arnrich, B., | activity (EDA) approach to select the | discriminant
Schumm, J., La feature. analysis (LDA)
Marca, R., (No Specified) -SVM
Troster, G. and -Nearest  class
Ehlert, U center (NCC)
(2010) algorithm.
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Rani, P., | -Electrocardiogram Anxiety index -Fuzzy logic
Sarkar, N. and | (ECG) -Regression three
Adams, J | -Electromyography
(2007) (EMG)

-Electrodermal

activity (EDA)

-Temperature
Reanaree, P., | Electroencephalogra | “Presented algorithm | -(No specified)
Tananchana, m (EEG) condition for stress
P, > (Band used: | detection”
Narongwongw | Alpha) (No specified)
athana, W. and | -heart rate

Pintavirooj, C
(2016)

Furthermore, since EEG is one of the signal-based collection techniques,

there are numerous ways to collect signals. In this study, there are different types of

signal based collection techniques and table below has summarized those analysis

methods which contain EEG features from previous works.
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Table 2.5: Summary of Methods Used for Other Applications from Previous

Studies

Authors

EEG Feature Used & Purpose

Acharya, U.R., Fujita, H., Sudarshan,
V.K., Bhat, S. and Koh, J.E
(2015)

Topic related: Epilepsy diagnosis by using
entropy.
Time Series Analysis:
i)Approximate Entropy (ApEn)
= to appraise the signal variation
instability
i) Sample Entropy (SampEn)
= to scale the signal regularity
iii) Spectral Entropy (SEN)
= to evaluate entropy using amplitude
of power spectrum
iv) Permutation Entropy (PE)
= to measure the complexity
v) Wavelet Entropy (WE)
= to measure the energy in different

frequency bands

Mumtaz, W., Xia, L., Malik, A.S.
and Yasin, M.A.M
(2013)

Topic related: Classified the environment of
2D and 3D physiological conditions
Time Series Analysis:
i )YSample Entropy (SampEn)
i) Approximate Entropy (PE)
iii) Composite Permutation Entropy Index
(CPEI)
= Advanced of PE, to reflect the time
series complexity
iv) Fractal Dimension
= Consider the irregularity and

complexity

v) Hurst Component
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= To appraise the properties of
correlation and self-similarity
vi) Hjorth Complexity and mobility
= To evaluate set of parameters:
activity, mobility and complexity of

EEG signal.

Ahmad, R.F., Malik, A.S., Amin,
H.U., Kamel, N., Qayyum, A. and
Reza, F (2015)

Related topic: Classified the active and
resting state using nonlinear feature

Time Series Analysis:

1)Sample Entropy (SampEn)

i) Approximate Entropy (PE)

iii) Composite Permutation Entropy Index
(CPEI)

Khairuddin, H.R., Malik, A.S,,
Mumtaz, W., Kamel, N. and Xia, L
(2013)

Related topic: Analyzed the regularity of
EEG signal in adult while playing 2D and 3D
game

Time Series Analysis:

i) Hjorth Parameter

i) Composite Permutation Entropy Index
(CPEI)

Ergen, M., Saban, S., Kirmizi-Alsan,
E., Uslu, A., Keskin-Ergen, Y. and
Demiralp, T

(2014)

Investigate the oscillation of event-related
which jointed with Stroop Test.
Time Frequency Analysis:

-Wavelet Transform (No specified)
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CHAPTER 3

METHODOLOGY

3.1 Introduction

In this chapter, the project activities and flow is discussed. The equipments or tools
that required are given. During the experiment, the EEG data were collected by using
EEG device through the software known as Emotiv Software Development kit. Next,
the pre-processing for EEG data was done through EEGLAB in order to remove
artifacts. In the end, the new data was analyzed by using MATLAB which will be
explained further in this chapter. Based on Figure 3.1, the visual representation of

basic project flowchart is given.
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3.2 Equipments and Tools

3.2.1 Hardware

i.  Emotiv EPOC+ headset kit
- Headset assembly with rechargeable battery, USB dongle, Hydration
sensor pack (16 sensor units), Saline solution, Battery or USB charger
ii. Laptopx?2

iii.  Earphone x1

3.2.2  Software

i. MATLAB
ii. EEGLAB
iii.  Minitab 17
iv.  Microsoft Excel
v.  EmotivPRO Software

3.3 Procedure of Data Acquisition and Experiment Design

Before conducting the experiment, all the subjects were required to fill in the consent
form together with the perceived stress scale (PSS) and music-stress questionnaires.

After that, the subjects were just prepared for data acquisition.
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3.3.1 Consent Form

Consent form (see Appendix A) is a form that was provided for potential research
subjects in order to obtain their agreement to participate in the research study. It is a
form that is required to be signed by all the subjects before conducting the
experiment. In the form, it provided sufficient information about the experiment
procedure, purpose and precaution that was required to make aware by the subjects.
Based on the above explanation, the rest of the procedures will be continued once the

subjects made an agreement and signed the consent form.

3.3.2  Perceived Stress Scale (PSS-14) and Music-Stress Questionnaires

In this study, Perceived Stress Scale (PSS-14) is used to investigate the stress level. It
was originally developed in 1983 and is a psychology and stress assessment
instrument to measure the stress perception. According to Cohen et al. (1994), it is a
measure of the degree to which situations in one’s life are appraised as stressful. In
the PSS questionnaire (see Appendix B), the questions are generally easy to
understand, in which thoughts and feeling were questioned during the last month. For
each question, the response alternatives are simple to grasp through the appropriate
indicated scale number. By doing so, the higher the score obtained from an

individual, the greater the individual is vulnerable to stress.

Other than that, Music-Stress Questionnaire also used in this study and shown
in Appendix C. Same as PSS, the questions are straight forward and the response
alternatives are simple. It asks about individual’s preferences about music as well as
some related questions toward stress in life. Once both questionnaires are completed
and the scores are finished computed for each subject, it will be used for comparison

with the feature obtained from the EEG signal to have accurate analysis.
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3.3.3 EEG Data Acquisition

There are three main items that are required in this section which include Emotiv
EPOC+ Headset, EmotivPRO Software and laptop. In the beginning, all the subjects
were required to wear the headset and check for the electrode condition before start
of experiment. However, it consists of number of steps to be set up first before
wearing the headset which will be covered in the next section. After that, the
experiment starts and the EEG data signal will be recorded through the laptop by

using Emotiv EPOC+ Headset. Figure 3.2 shows the basic process of data acquisition.

Figure 3.2: Basic Process of Data Acquisition
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3.4 EEG Data Pre-processing (remove artifacts)

In terms of signal processing, there are always consist of unwanted signals that are
represented as noise. There are known as artifact. Various types of artifact are
coming from distinct sources that either internally or externally. Artifact from
internal sources are caused by physiological activities of the subject which include
body movement, exhale and inhale cycle (respiration), cardiac cycle, blinking of eyes
and etc. In addition, cable movement, interference of environment and loose of
electrode due to the environment and equipment effects are considered as the
external source of artifacts (Islam, Rastegarnia & Yang, 2016; Bhattacharyya et al.,
2013). Since artifacts are referred as unwanted signals, they are required to be
removed from the recorded data in order to obtain more accurate input signal for
further analysis. In this study, the pre-processing of the EEG data is done via
EEGLAB. By doing so, all artifacts will be removed regardless of it sources. In order
to remove the artifacts, standard procedures and steps of using the EEGLAB are
shown in Appendix G.
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35 Cost Analysis and Project’s Sustainability

A cost analysis can be defined as a detailed outline or procedure for estimating all the
costs involved in the project. It takes both quantitative and qualitative factors into
account for analysis of the value for money for a project. By doing so, it can be
compared alternatives and prepared budget in order to achieve more efficient work.
In this study, several equipments and software are used in order to obtain accurate
analysis result. Table 3.1 shows the cost analysis of the hardware and software that

are used in this project.

Table 3.1: Cost Analysis

Hardware/ Software Market Price Cost Spent
*Free
Emotiv EPOC+ headset kit $799.00 (Sponsored by
supervisor)
*Free
Laptop x2 RM 1500.00 — RM 2000.00
(Own laptop)
*Free
Earphone RM 20.00 — RM 50.00
(Own earphone)
MATLAB $940 - $ 2350 *Free
EEGLAB - *Free
Emotiv+ Software $99.00 $99.00
Minitab 17 $30-$300 *Free

$99.00 = RM 400.00

Total Cost Spent
(Exact RM 393.89)

Besides, project’s sustainability is a systematic concept which related about
balancing of economical, social and environmental interest. By considering the
sustainability of project, it can actually reduce the negative impact toward the
technology worldwide. However, for this project, sustainability is not taken into
account during the project’s design as there is not any impact on environment in this

study.
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3.7 Project Management

Table 3.2: Gantt Chart of FYP |

Details/Week

Project Proposal / Title

Selection

Literature Review and
Research Work

Introduction of the Project
(Report)

Methodology of the Project
(Report)

Feature extraction and

selection

Future direction

Progress Report Submission

Oral Presentation

Table 3.3: Gantt Chart of FYP 11

Details/Week

Data Recollection

Analysis of data: Feature

extraction and selection

Improvement

Result and Discussion

Conclusion and

Recommendation

Progress Report Submission

Final Report Submission

Poster and Oral Presentation
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CHAPTER 4

RESULTS AND DISCUSSIONS

4.1 Introduction

In this chapter, the results of the project will be discussed. The results of power
analysis which includes beta power and alpha power will be analyzed. The
behavioral data analysis will also be discussed in this chapter which includes the
average response time and test accuracy for the Stroop tasks. The parameters such as
CPEI, ApEn and SampEn obtained from the time series analysis of EEG signal will
also be interpreted in this chapter. All parameters mentioned above are investigated

and the relationship with each other is analyzed in detail.



4.2 Perceived Stress Questionnaire - 14 (PSS-14)

PSS-14 determines subjects’ thoughts and feelings in relation to how uncontrollable
and unpredictable their lives in the last month. There are 14 questions with different
levels of score which include seven positive items out of 14. These positive items
describe the positive feelings, in which the score must be reversed for accurate
computation. Table 4.1 presents the different score levels based on different type of
items. Since the largest score for each item is 4, the maximum score range for the
PSS-14 questionnaire is from 0 to 56. Based on the range, the stress level of each

subject can be identified and it can be classified into three distinct stress groups: low,

moderate and high as shown in Table 4.2.

Table 4.1: Score Level in Different Type of PSS-14 Items

Scores (negative items) | Scores (positive items) “feeling”
0 4 Never
1 3 Almost Never
2 2 Sometimes
3 1 Fairy often
4 0 Very often

Table 4.2: Scores Range for Different Stress Groups

Scores ranging

Stress group

0-18 Low stress group
19 - 37 Moderate stress group
38 - 56 High stress group

Figure 4.1, it shown number of subject in different stress groups. It is
observed that majority of the subjects belong to the moderate stress group (90 % in
Figure 4.1 (a)). In other words, 45 subjects out of 50 are in the moderate stress group.

Only small percentage belong to low and high stress group which is indicated as 4 %

(2 subjects) and 6 % (3 subjects) respectively
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Figure 4.1 (b), the control group exhibits similar behavior as the experiment
group. There are 87 % 13 subjects in moderate group and one each in low and high
stress group (13 % combined). According to PSS-14 questionnaire and the result
above, the stress level faced by the subjects can be categorized into low, moderate or
high level.

Number of subjects in Number of subjects in
dlfferen'_t stress group - different stress group -
experiment group control group
®Low mModerate = High ®Low ®mModerate ™ High

6%

7%

(a) (b)
Figure 4.1: Number of Subjects in Different Stress Groups — (a) Experiment
Group (total 50 subjects) (b) Control Group (total 15 subjects)
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CHAPTER 5

CONCLUSION AND RECOMMENDATION

51 Conclusion

In this research, the EEG signal processing methods are used to analyze the cognitive
flexibility via Stroop test on different stress groups with and without music. The
stress level of the subjects was calculated by using the PSS-14 questionnaire and the
Stroop test experiment was designed to act as stressor to evaluate subjects’ stress.
Based on the experiment, the effect of music towards different stress groups and
tasks was identified and observed. In order to analyze the EEG signal, several
features were extracted; e.g. power (beta and alpha band power) and time series
features (Composite Permutation Entropy Index, Approximate and Sample
Entropies). With these features, the changes in the power and complexity level of

EEG time series were identified.

For congruent task with no music induced, the response time and task
accuracy performance increased from low to high stress group. Based on the overall
result, all the subjects responded faster and obtained more accurate result in this
stage. Besides, higher average beta power and lower average alpha power were
obtained. The average CPEI, ApEn and SampEn values also showed the same result
as beta power, in which all the values were high as compared with baseline. When
music was induced in the congruent task, there was no significant change of the
response time and accuracy performance among all stress groups. However, the
average beta power decreased and alpha power increased as compared to no music
situation. Similar to the time series features, all average parameter values increased

when music was presented.
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For incongruent task in no music condition, higher stress group required more
response time. However, the accuracy results showed no significant changes in
different stress groups. The overall result indicated that the longest time and lowest
accuracy obtained as compared to other tasks. The highest mean beta power was
present in this task and the task showed low mean alpha power than congruent task.
CPEI, ApEn and SampEn results also showed the higher value in this task. In music
environment, the response time taken by moderate and high stress groups had
decreased but no significant effect of music in low stress group. For accuracy result,
it showed no significant difference among all groups. The average beta power
decreased whereas the average alpha power increased similar to the congruent task
with music condition. CPEI, ApEn and SampEn indicated that the complexity and

irregularity levels were increased as compare to the task without music induced.

For the mix task without music presented, the response time result showed
similar trend as congruent and incongruent tasks, in which the higher stress group
takes longer time to respond than lower stress groups. The accuracy result showed no
significant differences among all stress groups in incongruent task. According to the
beta results, the average beta power was higher than congruent task and lower than
incongruent task. Unlike the beta power, the result showed for alpha power obtained
the lowest average value as compare to others. The CPEI and SampEn results
showed the same approach as beta power, these values were higher than congruent
but lower than incongruent task, as expected. ApEn showed the same observation as
alpha power result in no music condition. As music was induced to mix task, the
response time decreased but no significant effect of music on accuracy result for all
stress groups. As compared to the overall result, it showed that music induced had
improved the response speed and accuracy performance. The average beta power
decreased, average alpha power increased as compared to no music condition.
Similar to the congruent and incongruent tasks, all value of parameters was also

increased when music was introduced.

In low stress group, the overall results showed that there were no significant
effects of music. In moderate stress group, the results of response time and accuracy
depended on the task difficulty level, where more difficult task resulted in longer

response time with less accuracy and vice versa. The beta and alpha powers in
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moderate stress group were higher than low stress group but lower than high stress
group. Same result was obtained for the CPEI, ApEn and SampEn. When music was
induced, the overall response time, accuracy, CPEI, ApEn and SampEn results were
increased. Yet, the average beta power had decreased with no significant change in
average alpha power. In high stress group, the overall results and observations were
equal to moderate stress group. The only different was the average alpha power had
increased when music induced where moderate stress group does not follow this

pattern.

Analysis of different brain lobes show varied pattern for both music and
without music conditions; as it depends on the task difficulty level or specific brain’s
function. For example, the average ApEn and SampEn values of frontal and occipital
lobes increased in presence of music. This result shows that the music distracted the

subjects and resulted in more complex and irregular signal in these regions.

According to the statistical test, it only indicated the significant result
obtained for different Stroop tasks. In other words, the analysis results obtained for
different stress groups and brain lobes were insignificant in this study. Therefore,
based on this significant results, it was found that the background music can release
subjects’ stress and improved their task performance as beta power decreased with
faster response speed and higher rate of accuracy. However, it created distraction to
our brain due to higher complexity and irregularity signal which may cause by any
unpredicted reasons as human brain was a complicated organ. This needs further

research.
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5.2 Recommendations

In this study, the EEG signal was recorded by using Emotiv EPOC+ headset which is
portable and user friendly. However, it can be occasionally difficult to use during
data acquisition due to the thickness of subjects’ hair or head size. For example,
different people with different hair style require different adjustment of the headset
and it would take longer time for adjustment. Since the headset consists of numerous
electrodes to receive the signals from the brain, it is easy to detect the subjects who
have the shorter and thin hair style but may get poor signal towards the one who have

a longer and thicker hair style.

Other than that, the subjects that mainly focused in this project were from the
age ranging of 20 to 25 years and all results were analyzed among all subjects
without separated into different gender. Therefore, we can choose and consider
subject from different walks of life and analyze them into different gender in future
study. Besides, only one type of music that was used in the research. Thus, different

music genre can be used in future work to obtain deeper analysis.
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APPENDICES

APPENDIX A: Consent Form

CONSENT FORM
RESEARCH TITLE:
ANALYSING AND MONITORING OF STRESS LEVEL BY USING EEG

RESEARCHER’S NAME - NG JIAN TONG
REGISTRATION NUMBER : 13AGB03420

Purpose of This Study

The purpose of this study is to analyze and monitor the stress level by using EEG. In
this study, the collected EEG data will be used for research purpose only.

Qualification of Participations

Basic requirements for an individual to participate in this EEG experiment:
1) Any gender (male or female).
2) No mental disorder or health problem.
3) No physical disorder that can affect the general well-being etc.
An individual cannot participate in this EEG experiment if one of the following
applies:
1) Not willing to sign the consent form.
2) Head surgery has been performed.
3) Under daily medication.
4) Skin allergies.
5) Any psychological disorders.
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Note**: If any of the above condition present in participant, please contact the

researcher as soon as possible.

Preparation at home

Please ensure that the following steps must be fulfilled before you come to attend the

experiment.

Wash and dry your hair before hand

Do not use gel and hairspray

- Do not use make-up or any face cream

Experiment Procedure

Firstly, a consent form will be given for participant endorsement and a questionnaires
need to be answered before the experiment start. Once all the paper works have been
completely done, the participant will be required to wear an Emotiv EPOC+ headset
for experiment setup preparation. After all the setup has been done, the experiment
will start to take place, in which the experiment processes are described as bellow.

Experiments:

2 Y2 minutes of EEG recording with eyes open and 1 minute rest time.
2 % minutes of EEG recording with eyes closed and 1 minute rest time.

2 ¥ minutes of EEG recording with listen to music and 2 minute rest time.

N

EEG recording for approximately 120 seconds of Stroop color-word test:

Congruent and follow by 1 minute rest time.

5. EEG recording for approximately 120 seconds of Stroop color-word test:
Incongruent and follow by 1 minute rest time.

6. EEG recording for approximately 120 seconds of Stroop color-word test:
Congruent + Incongruent and follow by 2 minutes rest time.

7. Repeat step 4 to 6 while listen to music.

8. End of experiment.

Note**: Please kindly note that any movements, adjustments, blinking of eyes and
lose of concentrations should be avoided during the EEG recording process.

However, all of these can be done during the rest time.
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Risk

There do not have any risks involved in this experiment.

Reporting Health Experiences

Please kindly inform the researcher if there have any issues or other unusual health

experiences during this study.

Participation in the Study

It is extremely voluntary for an individual to participate in this study. An individual
have the rights to refuse the participations or stop it at anytime. The participations
may also be stopped by the researcher if an individual fails to follows the proper

instructions given.

Confidential

The information of an individual will be kept confidential and will not be made
public unless disclosure is requires by law.

Data obtained or collected in this study do not identify any particular individual that
will be used for knowledge purposes only.

By signing on the consent form, an individual’s acknowledgment, recording

authorization, review and storage of information are described as above.

Signatures
In order to participate in this study, an individual must sign and date the signature

pages. (will be signed during the experiment day)
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APPENDIX B: Signature Page of Consent Form

PARTICIPATION INFORMATION AND CONSENT FORM
(SIGNATURE PAGE)
RESEARCH TITLE:

ANALYSING AND MONITORING OF STRESS LEVEL BY USING EEG

RESEARCHER’S NAME : NGJIAN TONG

In order to participate in this study, you or your personal representative must sign on

this page.

By signing this page, | am confirming the following:

1) 1 have read and understand all of the information in this Subject Information
and Consent Form including all the experiment procedure, qualifications and
also the risks in this study.

2) All the questions have been answered by the researcher for clearly
understanding.

3) | agree to be part of this research study and follow the study procedures as
researcher said.

4) 1 agree that the collected data may be used for future research and store
securely.

5) 1 might be stop to participate in this study at any time.

6) | have retained a copy of this Subject Information and Consent Form for
myself.

Participant Name I.C No. (New)

Signature of Participant Date (dd/mm/yy)
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APPENDIX C: Perceived Stress Scale (PSS-14) Questionnaire

Name: Date:
Age: Gender: Status: Degree / Master / PhD / Others

Perceived Stress Scale — 14 (PSS -14) Questionnaire

The questions in this scale ask you about your feelings and thoughts during the last
month. In each case, you will be asked how often you felt or thought a certain way.
Although some of the questions are similar, there are differences between them and
you should treat each one as a separate question. The best approach is answer each
question fairly quickly. That is, don't try to count up the number of times you felt a
particular way, but rather indicate the alternative that seems like a reasonable
estimate.

almost

never sometimes
never often often

fairly very

1. In the last month, how often
have you been upset because of - P P P P
something  that  happened
unexpectedly?

2. In the last month, how often
have you felt that you were P P P

. - -
unable to control the important
things in your life?
3. In the last month, how often
have you felt nervous and| . . . .

"stressed"?

4. In the last month, how often
have you dealt successfully| . . C C
with irritating life hassles?

5. In the last month, how often
have you felt that you were
effectively coping with| . . . .
important changes that were
occurring in your life?
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In the last month, how often
have you felt confident about
your ability to handle your
personal problems?

In the last month, how often
have you felt that things were
going your way?

In the last month, how often
have you found that you could
not cope with all the things that
you had to do?

In the last month, how often
have you been able to control
irritations in your life?

10.

In the last month, how often
have you felt that you were on
top of things?

11.

In the last month, how often
have you been angered because
of things that happened that
were outside of your control?

12.

In the last month, how often
have you found vyourself
thinking about things that you
have to accomplish?

13.

In the last month, how often
have you been able to control
the way you spend your time?

14.

In the last month, how often
have you felt difficulties were
piling up so high that you could
not overcome them?
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APPENDIX D: Music-Stress Questionnaire

Name: Date:

Age: Gender: Status: Degree / Master / PhD / Others

Music-Stress Questionnaire

1. What genres of music do you enjoy listen to? (Can select more than one)

2 Country 2 Hip-Hop/Rap " ska (including Ska
" Jazz and Blues " Rock punk and Reggae)
-
= Easy listening / = Pop (mainstream Rhythm & Blues
music without genres eg. pop- (R&B, especially
lyrics rock, "radio™ contemporary
o music) R&B
Electronic (all
subgenres) / metal " EDM (dupstep,
house, techno)
2. How enthusiastic are you about listening to music?
O Not Enthusiastic C Enthusiastic O Absolutely
- - Enthusiastic

Somewhat Very Enthusiastic

Enthusiastic

3. Does music help you deal with stress?

Yes, significantly © Not really

e Yes, partially “ Notatall
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4. How many hours a day on average would you say you consciously listened to

music?

© 0-1hour © 5_7hours © More than 12
© 1-3hours © 7-9hours hours

© 3-5hours © 9-12hours

5. How often do you listen to music while you do homework?

- i

f__
Never

Sometimes Always

0 Barely S Frequently

6. How often do you listen to music while you study for an exam?

© Never © Sometimes S Always
- -

Barely Frequently
7. How often do you listen to music while you exercise?
“ Never © Sometimes © Always
- -

Barely Frequently

8. How often do you listen to music when you're in physical pain? For example,

headache, stomach ache, muscle ache, etc.

“ Never © Sometimes © Always
' Barely S Frequently
9. How often do you listen to music when you're sad?
- - . C
Never Sometimes Always

Barely ¢ Frequently



10. How often do you listen to music when you're angry?

11. How often do you get stressed?

-

-

Never

Barely

Very often during
a day

A few times a day

i )
Sometimes

Frequently

-

A few times a

A few times a

Always

A few times a
year/Not enough

to remember

12. What are sources of stress for you? (Can select more than one)

=

r

Family problems

Mental illness

Elder/Child care issues
Financial issues

Legal issues

Grief and loss
Communication difficulties

Relationship issues

=

r

Work

School

Addictions

Health concerns
Time management
Change management

Anger management
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APPENDIX E: Emotiv EPOC+ Headset Set Up Process

According to Emotiv Epoc User Manual, (2014), the detail of set up process will be

illustrated as below:

Setp 1: Hydrating the sensors and sensors assembly

There are total of 16 white felt inserts inside the Saline Hydration Sensor Pack. All
of these inserts will be attached in the arms of headset which must be wetted by
using saline solution. However, it should only be wet to the touch instead of soaking
wet. Therefore, each of the felt inserts inside the pack should be checked to be wetted
properly before used. If there are any felt inserts with insufficient wetted, one or two
drops of saline solution must be added. Besides, the large white hydrator pad can be
saturated by shaking the closed hydrator pack after few drops of saline are added to it.
This will help to maintain the moisture for each of the inserts when they are not in
use. Based on the figure below, it shown the graphic view of how to add the saline

solution in order to keep the felt inserts wet.

| Saline solution

White felt inserts

| Saline Hvdration Sensor Pack | | Large white hvdrator pad |

Figure E1: Saline Hydration Sensor Pack and Saline solution (Emotiv Epoc
User Manual, 2014)
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Once the wetting process is completely done, all the sensor units and the
wetted felt inserts are removed from the pack and mounted it into the headset arm.
After that, the definite “click” can be felt by the way of turning the sensor units in
clockwise direction. It will indicate that the sensor had fit and installed correctly in
the headset arm. If there have any difficulties, a little more force is applied until the
user feel it, yet be aware that too much excessive force might cause the damage to
the sensor. When sensor units are not in use, it can be removed by just turning the

sensor units in anticlockwise direction as shown in Figure 2.

Turn clockwise to fit Turm anticlockwise to remove
Figure E2: Way to Fit and Remove the Sensor Unit from Headset Arm (Emotiv
Epoc User Manual, 2014)

Step 2: Headset pairing

In order to pair the headset, the USB Transceiver Dongle is required to be inserted
into computer’s USB port. When the transceiver has paired with the nearby headset,
it can be noticed that a single LED would flash slowly after one or two seconds. The
transceiver should automatically recognized by the computer to indicate that the
hardware is ready to use. After that, the headset is turned on by using the switch at
the headband rear and holds it close to the USB transceiver. If the headset is paired,

it can notice that a new steady LED (blinking rapidly) will show on the receiver.

Figure E3: Way of Transceiver Plug-In and Turn on the Headset (Emotiv Epoc
User Manual, 2014)



47

APPENDIX F: Headset Placement’s Procedures

Firstly, the headset is gently slide down from the top of head by using both hands just
as Figure 1 - A. After that, the sensors with the black rubber inserts are placed
carefully on the bone which located behind each of ear lobe in order for correct
operation. Besides, make sure that the two front sensors of the headset should be
placed above both eyebrows with approximate three fingers width or 2.0 to 2.5
inches for accurate placement. Once the headset is in position, the two reference
sensors must press and hold for about five to ten seconds which are indicated as the
arrow shown in Figure 1 — D. These reference sensors are significant as good contact
of it’s the key for good signal. In order to identify the condition of sensors
connection, it can be noticed through the Epoc Control Panel in the computer screen
(see Figure 2). Through the Control Panel, there are several colors that can be used to

indicate the signal condition as classified in Table 1 below.

Figure F1: Headset Placement (Emotiv Epoc User Manual, 2014)

Table F1: Signal Condition Represented in Control Panel

Colors Condition

Black No signal
Red Very poor signal

Orange Poor signal

Yellow Fair signal

Green plus some Yellows (Acceptable)
Green plus Black or Orange plus Red (Not Acceptable)
All Green Ideal signal (most recommended)
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Figure F2: Signal Condition in EPOC+ Control Panel (Good Signal Condition
Representation)

Based on the table, good signal will show the green color for each contact on
the screen. Whenever there have any poor signal represented, it can be press and hold
on the sensor for about few seconds to improve the condition. If still poor signal, the
sensor unit must be checked to see whether the wetted felt insert is indeed mounted

into the headset arm or not else checked for the position.



APPENDIX G: Procedures of Data Pre-processing

(Remove Artifact by Using EEGLAB)

Step 1: Open the EEGLAB in MATLAB software
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Firstly, the EEGLAB can be opened by typing a command “eeglab” in the command

window of the MATLAB software. It can be seen in figure below where the

EEGLAB window will pop out after the command finished running. Note that the

“importEEGlab().m” file must be first opened in the Editor Window before typing

the command.

Command Window

»» eeglab

eeglab: options file is C:\Users\JT Ngleeg optiona.m

\4

Type the command for calling EEGLAB

EEGLAR: adding "dipfit" v2.3 (see »» help eegplugin dipfit)
EEGLAB: adding "firfilt" v1.6.2 (see »» help eegplugin firfilr)

Running

nrnragg

Figure G1: Command Window of MATLAB

[« EEGLAB v14.0.0
Fi

ile Edit Toels Plot Study Datasets Help

— No current dataset

- Create a new or load an existing datasect:

Use "File > Import data” (new)
Or ™"File > Load existing dataset” (old)
- I new,

"File > Import epoch info" (data epochs) else
"File > Import event info" (continuous data)
"Edit > Dataset info" (add/edit dataset info)
"File > Save dataset” (save dataset)

- Prune data: "Edit > Select data”

- Reject data: "Tools > Reject continucus data”

- Epoch data: "Tools > Extract epochs™

- Remove baseline: "Iools > Remove baseline™

- Run ICA: "Tools > Run ICA"

Figure G2: EEGLAB Window
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Step 2: Import the recorded EEG data

After that, the recorded EEG data can be imported into the EEGLAB through the
MATLAB Window. Note that the data file that is used to import into EEGLAB must
be in .CSV format else it cannot be imported. Besides, the “open_file.m” file need to

be opened in the Editor Window before started. The processes are shown as below:
a) In MATLAB Window —.Browse the data folder and open it (will show all
the data in the Current Folder) > @type the command “[ecgdata] =

open_file()” in the command window

o B g | mmOs6- =3 [ &
= GoTo v Comment % 5% &
New Open Save - % &5 4 Breakpoints || Run n and
- - - = Find = Indent = - ~  fadvance Time
e NAVIGATE EDIT BREAKPOINTS RUN
. C: » Users » JTNg » Desktop » EEG data (completed version) »
Current Folder @ |Eg EdjjqreeiisversH TRy Beskeepl,EEC data (completed version\importEEGlab.m
Name . importEEGlab.m 2 | open_filesm |+
2 ALY Y et
'1;1129'1“:5“[ 2 - EEG = pop_importdata('data’,eegdata,'srate’,128); % import data from MATLAB array
%sg:ﬁg 3 -  [ALLEEG, EEG, CURRENTSET] = pop_newset (ALLEEG, EEG, 0, 'setname’,'eegdata’,’'gui','off'}:
54 29-a.c5v : n',0): =
£24] 30-1.C5V len'.0}; % event chammel | —
302,05V & e autodetect'}); % channel locations
654 30-3.C5v v
4] 30-4.05v
] sbsPoweralpha.m
#) eeg PowerBands.m . . . .
P et Open the required .m file to Editor Window
] open_files.m

- _ )4 i |
-3 v icrosoft Office Excel Comma S%u\;e:% ~ I
Workspace @ | | Command Window
Name Value /

>» [eegdata] = open files(}; '
~ ST OIS TITE T CTTUSe:s\JT Ngleeg options.m

[63] ALLcom
[ ALLEEG EEGLAB warning: there can be only one EEGLAB window, closing old one
|-t ans EEGLAB: adding "dipfit"” v2.3 (ses >> help eegplugin_dipfit)

[ CURRENTSET 0 EEGLREB: adding "firfile" v1.6.2 (see >> help eegplugin_ firfile)

Figure F3: MATLAB Window

b) After that, the recorded data file will pop out — select the recorded data .CSV
file > open > @run the importEEGIab().m file (refer back the figure
above)—> the data is imported into EEGLAB Window

) icka fi E =
b Gkale | EEGLAB v14.00 - o .
T L+ EEGdata (completed version) w10 | Search EEG data (completed v, P TR - - [ @
New folder #1: eegdata
Name Dt
RAWEEG_Sia 672 Filename: none
IR Channe1, 14
-2 Frames per epoch 17000
613
s Epocns 1
&2 Evenna nene
= -
22 > 128
[TES 0.000
24 132.808
&3 e
@or nnenown
33 6/23/2017 %04 AM Micr es
< ICA weights Ne
U] [esvriesciem T Dasases atse (Mb) 11
[ open | Cancel

Figure F4: Import the Recorded EEG Data from Data File into EEGLAB



Step 3: Open the recorded EEG data through the EEGLAB

o1

In order to open the recorded EEG data Window, it must first be filtered. For Emotiv

EPOC+ headset, the sampling rate, fs that is used for recording the data is 128 Hz

which is fixed. Therefore, the maximum frequency required must be less than fs/2 as

Nyquist Theorem stated in term of signal processing so as to prevent the redundant

aliasing frequency component in the data signal. In this case, the filter used and the

setting value were identified as below.

a) In EEGLAB - click Tools - select Filter the data - click Basic FIR filter

(new, default)

EEGLAB v14.0.0 - = “
File Edit | Tools | Plor  Stud Datasets  Help ~
21 Change sampling rate
Filter the data L Basic FIR filter (new. default)
Re-reference = FIR filt
oy Interpolate electrodes N (equiripple) FIR filter
ham Reject continuous data by eye Moving average FIR filter
Fxa Basic FIR filter (legacy)
Enc
Eve a=
San b
Epd ooo
Epc sos
mar  Ovtormancepachrsiection s powm
Cha
xcs
Datas=c =a= 4

Figure F5: Selection to Open the Filter Window

b) Then the Filter Window pop out - type “1” for lower frequency pass band

- type “63” for higher frequency pass band - Dataset Window pop out =

click Ok

Note that the equation of Nyquist theorem, fmax < fs/2 (128/2 = 64)

Filter the data -- pop_eegfiltnew(

Lower edge of the frequency pass band (Hz)

Higher edge of the frequency pass band (Hz)

FIR Filter order (Mandatory even. Default is automatic™)

"See help text for a description of the default filter order heuristic
Manual definition is recommended.

| | Notch filter the data instead of pass band

Il Use minimum-phase converted causal filter (non-linearl, beta)
I | Plot frequency response

Help | cancel |

Dataset info -- pop_newset(

What do you want to do with the new dataset?

Ol

- o e

Mame it. eagdata Edit description

' Save it as file:

Some changes have not been saved. What do you want to do with the old dataset?

1 Overwrite it in memory (set=yes; unset=create a new dataset)

' Save it as file: Jrowse

Help cancel |

Ok

\

Set the frequencies

in Filter Window

Save the new
dataset in desired

file and

Figure F6: Filter Window and Dataset Window
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c) Go back to EEGLAB Window — click Tools - select reject continuous data

by eye - EEG data signal (wave view) pop out

-]
File  Edit

— #2

Fil
Cha
EFrs
Epc
Eve
San
Epc
Epc
Ref
Cha
TCH

EEGLAB v14.0.0

Tools | Plot Study Datasets  Help

Change sampling rate

Filter the data .

Re-reference

Remowe baseline

Rumn 1Ca ae
Remowve components B

Automatic channel rejection

atic epoch rejection
Reject data epochs
Reject data using |CA .

Locate dipoles using DIPFIT 2.x
= ey

Dato==c ==x= e

Figure F7: EEGLAB Window for Showing the EEG Data Signal

CANCEL =< <]

2 3

Chan. Time Value

0 = == AF4 3837 -1.1763

REJECT

Figure F8: EEG Data Signal Window (Waveform View)

Step 4: Remove artifacts

Once the data waveform is shown, it must be normalized first before continue as the

original signal looks “unstable” in Figure 3.9. If this step was skipped, the user may

remove the correct signal instead of artifact that lead to inaccurate result occurs.

After normalizing, the artifact can then be removed through the region selection in

the data waveform which will be shown more detail in Figure 3.9.



a) Click the “norm” button to normalize the signal

Normalization ——

s
1

_'t

53

“HE

HE .| f:3

Before normalize

After normalized

Figure F9: Normalized EEG Data Signal

b)

new data

Select the artifact region = remove it through “Reject” button - save the

Artifacts
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Figure F10: EEG Data Signal Before and

After Remove Artifact



